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ABSTRACT
The Drama Therapy Database: A Comprehensive and Interactive Bibliography

Kristina Bye

Drama therapy is a relatively new method of therapy. In the twenty years it has been
acknowledged as a professional field, a large body of literature describing its methods and
theories has accumulated. The aim of this project is to catalogue what has been written to
date, both by drama therapists and those who use drama therapy techniques. The database
contains references for approximately 1400 articles, books and videotapes. The Microsoft
program Excel 97 has been used to record the collected resources in a user friendly database.
Thus, this project contains three components: a computer disk containing the database itself,
a description of the assembly process, and a user’s manual. To be able to access the
information contained on the disk, the user must have available an IBM compatible computer
with Windows 95, a 3 5” disk drive, and the computer must have either Excel 97 or Quattro
Pro 8 installed on its hard drive. The written component, in two parts includes a description
of the assembly process, and contains a number of charts distilling the findings of the
database. The second part is a Technical User’s Manual, which consists of a clear set of
instructions on how use the important functions of the Excel Program. The document
contains two appendices. One is a list of the search terms that can be used to refine the
database, and the other is a hard-copy of the database itself. With this database, an interested
party can find all that has been written within the field of drama therapy on any population,

theoretical approach or technique, and define searches to their personal needs and interests.
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Part 1: The Process of Assembling The Drama Therapy Database:

Rationale:

In fulfilment of the Master’s Degree of the Creative Arts Therapies at Concordia University,
there is a research component. In the second year, this can take the form of a research paper
based on clinical work with your clients or as a research project that contributes a fresh
perspective on the field of Drama Therapy. Because I was philosophically unprepared to
conduct research with my clients, while working with them, and because of the constraints
of my internship placement, I decided to investigate a different type of research project. This

Drama Therapy Database is the result.

My intention is to catalogue every drama therapy article, resource and book written to date.
Of course, there is no absolute value that can be addressed to this endeavour as delimiting
where the field of drama therapy begins and ends. This, I have discovered, is a virtual
impossibility. However, at the time of this writing, there are approximately 1400 articles and
books catalogued pertaining to the techniques, practice and theories of drama therapy. It is
as comprehensive as the resources that I have available to me have allowed, and I am satisfied

that I have not missed any major contributions to the field.

I feel like this is an important task at this time as the first defining books on drama therapy,
Drama in Therapy, Volumes 1 and 2 (1981, Schattner and Courtney), were published nearly

twenty years ago, and are now out of print. Since then, the field has bourgeoned, training
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programs have been created, professional associations started, and the validity of the work
being done is starting to be recognized in much larger contexts. As we pass into the new
millennium, new resources will continue to be produced. At this stage, the volume is still
manageable. However, I hazard to guess, in the next five years it won’t be, if this type of
cataloguing is not done now. To my knowledge it has been done twice before, once in 1982,
and then updated in 1991. Others may have done this work but the products are not
commonly available, and certainly there are some comprehensive reference lists at the back
of some books, but to sift through these individually is not making use of the modern
conveniences of the computer age. For these reasons I have made this assembly of resources

and structured them in this manner for maximum enhancement of the field of drama therapy.

Structure of The Drama Therapy Database:

The database is written with the computer program Excel 97, on an IBM compatible
computer. It is interactive and simple to use. The structure of the Excel database allows the
capabilities of sorting and refining specific searches of the contents. The 1400 articles, essays,
videos/ audio tapes and books are organized into seven columns with the headings: Article
Title, Author(s), Journal Title/ Book Title & Editor(s), Date of Publication/ Publishers,
Population/ Context, Approach/ Techniques, and Other Keywords. It is accompanied by
a comprehensive User’s Technical Manual that describes how to use the Sort and Search/
Filter features, and how to Print the results (See Part 2: User’s Technical Manual). Appendix
A gives a condensed list of the descriptors and search terms that were used to classify the

found documents. The process of how I decided to define these parameters will be discussed
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later in this document. Appendix B is a hard copy of The Drama Therapy Database, sorted

by Author(s), Date of Publication, and then by Journal Title/ Book Title & Editors.

Delimitations:

In finding the various data entries, a decision had to be made in each case whether to include
it or not. Even before I started, I had decided noft to include Psychodrama references. The
volume of work in this discipline is so vast that I felt that it was not possible to include it and
do it justice, while maintaining the integrity of the drama therapy portion. I do acknowledge
the importance of the contributions of psychodrama in influencing the practice of drama
therapy, especially in some individuals’ work, and for this reason I did include some articles
about techniques that are often employed by drama therapists. I did, however, include most
of the sociodrama articles I encountered, because in terms of my understanding of
sociodrama, it falls in a grey area between the two disciplines. I included a number of
interesting articles comparing drama therapy and psychodrama, and a few essays by drama
therapists about psychodramatic techniques. I differentiated between the two disciplines based

strictly on the title of the work.

Not included because of their vastness, as well as the cost of retrieving the articles, are
Unpublished Dissertations. Their value is undeniable, and many have had their work later
published. However, the difficulties of finding complete listings, both in North America and
abroad, was too large a task for the scope of this initial database, and have been excluded for

these reasons. In the future, it would be a very worthwhile venture to catalogue and even
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assemble these previously done works, the volume of which is increasing exponentially, as

more training programs are created and the field grows.

As I have collected articles and references, other delimiting decisions have had to be made.
In my own experience of people employing drama therapy techniques, there is often a large
cross over with Sand Tray or Sand Play Therapy, especially in the early stages of dialogue
with a client. I have included the sand tray therapy articles I found as I worked, but did not

search for them individually.

The same is true of Play Therapy. My personal opinion of drama therapy when working with
children, especially under approximately seven years old, is that the difference between play
therapy, dramatic play and drama therapy is more often defined by the person conducting the
sessions and not by the techniques themselves. The differences would be virtually
indistinguishable to an observer. Many drama therapy theorists, especially those working in
Britain, use both methods, and have published articles within both disciplines. For these
reasons I have included the play therapy references I encountered in the research, but again

I did not search for them exclusively.

When I was looking at the interdisciplinary journals and books, often there were articles
aimed at Creative Arts Therapists or Expressive Arts Therapists. I have included many of
these, especially those that pertain to the distinction of Creative Expressive Arts Therapies

as its own profession. As you can see, because the nomenclature was not constant across
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various sources I have combined the two names as the label I have used in referring to such
articles, because it will provide a better search title for those looking for either word. At the

same time, it enlarges and defines the practice.

In terms of other Creative Expressive Arts Therapies, as with psychodrama, I cannot deny
how often various methods and techniques are borrowed and adapted for drama therapy
work. However, I only infrequently included articles that were not interdisciplinary (Creative
Expressive Arts Therapies) and employed drama therapy as part of the technique. There is
the occasional one, but I take ownership of the fact that they were included more out of

personal interest than out of relevance.

At times [ have included articles from the fields of Drama in Education, Creative Dramatics,
and Developmental Drama, especially those that are working with special populations. These
articles tend to be older, before or on the cusp of the development of drama therapy as a
distinct practice. I included these articles both for their historical value, and because, here
again, the differences are in the definition of the person conducting the sessions. The
techniques are relevant and valuable. I did not include the more recent articles and
publications from this field, with the exception of those written by well-known drama

therapists, generally before they crossed from teacher to therapist.

Occasionally Psychology/ Psychotherapy journals will reference drama therapy techniques,

without calling the work drama therapy. Role playing is a good example of this. When I
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encountered role play, enactment, recreation, scene playing-type descriptions in my research
I included them in the database. I also came across Action Therapy, which also seemed to
share very similar principles to drama thera;;y, therefore these articles, though not specifically
sought out, have been included too. I have included these types of references, though not
specifically about drama therapy, because they enlarge the knowledge of our techniques for

ourselves and others, and, if for no other purpose, help us define who and what we are not.

Though referenced often in many published works, I have not often included the writings of
major theorists outside the field of drama therapy, but upon whose principles much of the
drama therapy ethos is based. I made an exception in the case of both Goffman and Winnicott,
for whom I included one work each, because they were referenced so frequently by drama

therapists.

The other field from which I included the occasional article is Theatre. There are quite a few
articles written by, for the most part, psychoanalysists that compare theatrical texts to
therapy processes or contexts. I have included these, and when an author references play text
as a metaphor for therapy I generally label this Dramaturgy- Text/ Metaphor. The other area
of theatre research I have borrowed from are studies on the psychological effects of

performance on actors. I believe that these studies can also be related to clients of drama

therapy.

And, of course, I have included articles about Drama Therapy specifically. One of my major
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incentives for this project originally came from the frustration of not knowing who had
written what in the edited volumes of drama therapy work. Unless in possession of the book
it is often very difficult to find the contents and contributors, and I found myself and my
fellow students often missing important references for papers because one of us had not
bought the book yet. Thus, in the preparation of the database, I have not only included the
titlés of such books, but given a breakdown of each of the articles or essays contained within.
As well all the relevant articles from The Arts in Psychotherapy and Dramatherapy, The

Journal of the British Association of Dramatherapists (BADth) are catalogued and included.

Drama Therapy
41%

Creative Expressive Arts
Therapies
16%

Bibliography/
Literature Reviews
1%

Action Therapy
1%

Creative Dramatics/ Dramain

Educstion Anthropology/ Ri
7% pology/ Ritual/
Oramsturgy/ Theatre and Psychodrama/ Shamanism
Therzpy Sociodrama 2%

Figure 1. Breakdown of The Drama Therapy Database by Field
Figurel illustrates the breakdown, in percentages, of the various fields from which the

resources were collected. This is a function provided by the Excel program.



Collection of Resources:

As I have mentioned above, I have entered a large variety of information from a variety of
sources. My process in doing this has followed this path. My starting point was the PsychLitt
CD-ROM from the Concordia library. It was only current to 1997. A search for “Theatre”
and “Therapy” rendered nearly 200 articles, of which about 150 were relevant. The search for
“Drama” and “Therapy” resulted in about 179 articles. Many of these had to be discarded,
because often the abstracts referred to the “drama™ of peoples’ lives or the “drama” of their
experience in therapy. Out of the 179, I kept approximately 50 new articles because there was
also a large cross over with the first search. These initial 200 articles were the foundation of
the database. I downloaded the abstracts and used those keywords as a basis for my own
search terms. I entered each reference into the appropriate database columns one at a time

and then entered the search terms.

If T were to start this project again, I would keep track of where I retrieved each entry. This
would be especially valuable for validating my accuracy and correcting any errors I have
found. Unfortunately, it is quite detailed work and one error in typing can invalidate the
whole entry. As I collected entries, I often found inconsistencies in publication dates,
publishers, volume and page references. Reference lists in books can be particularly fallible
on this point, because once entered it is nearly impossible to spot the error. Another issue that
has surfaced from time to time are books that are published by more than one company,
especially when no edition is noted. I have used the more common publishing companies’

names in most of these cases because they have been easier to verify and because they are
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more readily available. I admit that there are some books I know exist, but because the lists
I had found did not contain a publishing date or publisher, I have not included them in this
version. There are entries that are incomplete anyway, but usually this is not my oversight,
but an unavailability of the correct information. If I am unsure of the reference, I have usually

noted it with a “?”.

From the PsychLitt download, I continued to the Internet. I accessed the Jessica Kingsley and
Routledge web pages (Jessica Kingsley’s is especially well organised and easy to use) as I
knew them as major resource publishers for the Creative Expressive Arts Therapies. Here,
occasionally, I was able to download the table of contents for edited books to manipulate in
the correct format and enter into the database. This was very useful when it happened, but
listings for edited books are not consistent. I was able to cross reference this information to
the hard-copy catalogues I had requested by email. At times, the catalogues contained

chapter breakdowns that the Webpage did not provide, and I typed these in by hand.

Obviously, I have a passion for both books and collecting. In my personal library I own a
large number of the basic drama therapy references. I used these quite often to verify accuracy
of my downloads and to fill in areas where information was missing. Interestingly, the
PsychLitt download would occasionally mention a random chapter from one of these books,
but not the rest. Those that I had not already captured, I entered by hand. From the original
resource, I was also better able to define my keyword entries more accurately. For the most

recent publications, I have had to depend solely on the downloads because I have not yet
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purchased the books themselves.

The Concordia library fortunately owns c':omplete sets of the two major drama therapy
reference journals, The Arts in Psychotherapy and Dramatherapy, The Journal of the British
Association of Drama Therapists (BADth). 1 photocopied the individual indexes of each
volume of these journals, and entered the information by hand. I went to the library, armed
with these print-outs, and wrote in the keywords after glancing over each article. I found out
after I had done this that 7he Arts in Psychotherapy has a Webpage with indexes of volumes
dating back to 1995. There are no abstracts, and I was not successful at downloading the
information in a format I could use, but I was able to print the most recent volumes that the
library had out for binding, and entered these by hand too. The address for The Arts in
Psychotherapy Webpage is entered in the database. The British Association of

Dramatherapists does not have any Web information that I could find.

The next step was to look at what I already had, and try to find Webpages for other
publishers that had numerous books on the list to see if there where some references that my
previous searches had missed. This was only marginally successful because some publishers
were either out of business or did not have Webpages. For those that were listed on the
Internet, the pickings were quite meagre. I tried the large on-line book stores. They came up

with a few items of some interest, but for the most part their listings were very incomplete.

At this stage I turned to written material in my possession. I used the two bibliographies I
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mentioned early, from 1982 and 1991, which were very complete and well formatted, but out
of date. I found many of historically interesting references on these lists. I imagine because
drama therapy literature was quite scarce,. even ten years ago, they included a number of
sources I have excluded, ie: dissertations, psychodrama and creative dramatics. However,
there were numerous entries to be copied from there. I must note at this point, I have not
researched what the legalities of using titles and authors’ names from other sources are. I

apologize to any people or resources that I have unwittingly mistreated or misrepresented.

After I had finished this process, the drama therapy database contained approximately 1200
articles. To verify the references I had already accumulated, and to discover what I was still
missing, I went back to my personal collection of books and journal articles and read through
each suggested reading, bibliography and reference list. As I encountered literature and other
resources that I had not yet found, I entered them. During the whole process I was continually
updating the search terms in the appropriate columns. I found another 200 or so articles this

way, to bring the total to approximately1400.

It is through this process that I found references that, at first glance, seemed to hold no direct
bearing to the field of drama therapy. My logic was that if I observed a resource that was
continually referenced by multiple drama therapists researching for their own articles, then the
work most likely merited inclusion. Another area in which I was liberal about including are
articles written by well-known drama therapists that were not specifically about the practice

of drama therapy itself. One of my goals was to include all the works published by certain
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individuals, even if the article seemed not be relevant. I did this to round-out the perspective
of what certain authors have achieved; and in so doing, highlight what other possible
extensions exist for drama therapy practi(.mners and to provide insight into some of the

outside influences and contexts at work on the individual’s methods and practice.

As I continued looking for more articles in the reference lists of other drama therapy articles,
I finally reached a point where the resources I was finding had already been included or seem
to hold more and more distant relevance to the database. I decided I had accomplished what
I had set out to do. With this information compiled and with the search terms entered to the
best of my resources, I went on to create the graphs that are included later in this paper. I
made these breakdowns of the information garnered to distill various points about what is

being accomplished within the field of drama therapy, and to highlight the influences upon it.

Rationale for the Choice of Row Headings and Database Organization:

The row headings, as mentioned earlier, are Article Title, Author(s), Journal Title/ Book
Title & Editor(s), Date of Publication/ Publishers, Population/ Context, Approach/
Techniques, and Other Keywords. The first column on the far left, Article Title, contains
the names of individual articles from journals and essays from edited books. They have been
kept separate from the books themselves, which appear in the same column as the journal
titles. This column is called Journal Title/ Book Title & Editor(s), and contains the name

of the editor books containing multiple essays.
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Figure 2: A Sample of The Drama Therapy Database
(Figure 2 is a sample of what The Drama Therapy Database looks like. These are the first ten

entries, when the database is sorted by author.)

The Author(s) column is self-explanatory, with the exception that due to the way the
database program functions, the lists appear in alphabetical order (when sorted by author) by
the first named entered in the cell. To find a specific author, who may not be listed first on the
publication, and thus not first in the cell data, it is necessary to use the Search/ Filter

function (See Part 2: The User’s Technical Manual).

The Date of Publication/ Publishers column contains information of both articles and books.
In the case of articles from journals, the date, the volume, the issue in brackets (if available)
and then the page numbers appear. In the case of books, the date of publication appears first,
then the place of publication, and the name of the publishing company. This is the column
where I have found the most inconsistences, so as I mention above, I have noted the
information I am not sure of with a “?”. The date of publication is always first so, if interested,

the user can order the database chronologically using the Sort function (See Part 2: User’s
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Technical Manual).

These first four columns are simply recorded information from a variety of other sources, and
have been subjected to little or no interpretation on my behalf. The same is not true for the

next three columns.

The following three columns Population/ Context, Approach/ Techniques, and Other
Keywords, have been designed for use with the Search/ Filter function and for easy topic
browsing for the user. Nomenclature is not common across various schools of thought and
has changed over time. Therefore, to make finding articles that are relevant to the user’s
needs easier and faster, I have selected search-terms to represent the major concepts of the
article and book; for example: “preschoolers”, “latency aged girls”, and “pre-adolescents” and
“ten-year-old boy” would all would all be labelled “Children” in the Population/ Context

column.

Designating the row headings names and search-terms, for the most part, were straight-
forward decisions. The column that has given me the most difficulty is Population/ Context.
I was very conscious of not using stigmatizing or pathologizing discourse in the creation of
the database. I have been caught between brevity and instant recognition of meaning and
political correctness. I am still not entirely comfortable with naming the column “Population”,
and have tried to soften the impact of assigning one or two words to summarize all that a

person in coping with, by adding “Context™.
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In the choice search-terms for the column, I tried to maintain this consciousness. I have
chosen to use, for example, “Schizophrenia” as opposed to “Schizophrenics” to avoid
labelling people by their diagnoses. I have used other terms like “Developmental Delay” (to
encompass what author’s called in the titles “Retarded”, “Learning Disabled” (in the British
context of the label, not North American), “Mentally Subnormal” and ‘“Mentally
Handicapped™) and “Psychiatric Disorders™ (to encompass labels like “Psychotic”, “Mental
Illness™ “Chronic Patients™ and “Sociopathic™) to summarize all that is implied in the author’s
choice of words without being pejorative or stigmatizing toward the person/ people in
question. It is important to note that many of the articles I have collected date back as early
as the 1930's, and, as with all things, there have been fashionable and widely accepted ways
of describing issues, diagnoses and coping styles. The words that I have chosen are the best
that I could determine based on the reality of the fact that we do label and stream people
based on our assessment of their needs, and I chose terms that are as close as possible to what
is deemed politically correct at the end of the twentieth century. (If you feel that I have not
succeeded in this consciousness, or in the process of using the database come up with better
search terms for any of the columns, please feel free to contact me and make suggestions. See

the end of The User’s Technical Manual for a contact number.)

Whenever possible I have put the person first, in terms of what we all have in common, age
(children, adolescents, adults, elderly) and sex (male, female). Figure 3 illustrates a
breakdown of the articles contained within the database classified by references to age. It

provides some insight into the concentration of attention to certain populations. In this graph
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I have excluded articles that are written with professionals as a target audience. It pertains
simply to articles that have mentioned the age of the individuals. This is somewhat skewed
as a result of the fact that not all articles discuss any client group at all, but describe simply
theory. The other factor that skews this chart slightly is that I have not accessed all the articles
individually, and if, this was the case, I have distilled the age of the population in question
from the title. Not all articles are so labelled, thus explaining the rather large percentage of
Non-specific or Unknown references. This does not greatly impact on the relative percentages

within the other fields however, as the number of unknown, age specific, articles is relatively

small.

N cific
op-specine or Children

- Adults
Elderly 4%
a%

Figure 3: Breakdown of the Drama Therapy Database by Age of Population

Outside of the breakdown by age, many authors reference more specific qualities of the
person that has led them into therapy. Figure 4 is a more specific breakdown by clinical

population. I used as the hundred percent value all the articles that where specific in their
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context or client group. As one can observe a large proportion of articles contained within
the database are aimed at other professionals, creative expressive arts therapists or drama
therapists, as their target audience. Most of these articles concern training, professional
development, supervision or professional associations. This chart is slightly skewed by the
fact that a few articles address more than one population at a time. Ifthis is the case, the same
article may have been entered as a value in multiple fields. My concern was not so much

numerical accuracy, but an overall view of who was being worked with and who was not

receiving as much attention.

Figure 4: Breakdown of The Drama Therapy Database by Specific Population
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The next column is the Approach/ Techniques. Within the field of drama therapy, there are
a number of practionners/ theorists who have developed their own distinct manner of
working; examples of these are Robert Landy’s Role Theory, David Read Johnson’s
Developmental Transformations, Renee Emunah’s Five Phase Model, Sue Jennings and Ann
Cattanach’s Developmental Paradigm/ EPR (Embodiment, Projection, Role) Model, Alida
Gersie’s Narrative Approach, and Steve Mitchell, Brenda Meldrum, Marina Jenkyns, Phil
Jones and Sue Jennings’ Theatrical Approach. Figure 5 shows all the articles specifically
about drama therapy in the database broken down by author. The total number of articles and
books that are specifically about drama therapy is approximately 700. These do not include

the articles written by drama therapists pertaining to other fields.

Johnson, David Read

5% Irwin, Eleanor C.

2%

Gersie, Alida
2%

Jones, Phil
2%

Grainger, Roger
2%

Cattanach, Ann
2%

Emunah, Rence
1%

Mitchell, Steve
1%

Jennings, Sue
8%

Figure 5: Breakdown of The Drama Therapy Database By Author



19

To briefly summarize these approaches, and how I defined them to label the resources of the

data base, I have included a short description of each.

-Robert Landy’s Role Theory is based on a number of influences, including Jungian
archetypes, Sarbin’s Role Theory, and to some extent dramaturgical-type analysis of stories
or text. At times his method of working holds some similarities to the Theatrical Approach.
His basic tenents are that the personality is a system of interrelated roles, and one needs
aesthetic distance in order to be able to observe them. This comes through storytelling,
myths, embodiment and projective techniques. The goal is to tolerate the ambiguity of the
roles that the individual plays and to create a more functional system (Landy, 1983, 1990,

1991, 1997).

-David Read Johnson’s Developmental Transformations is based on developmental
paradigms such as Piaget and Erickson. The method starts in early stages of sound and
movement and progresses toward role play and improvisations. Winnicott and Authentic
Movement also have influenced this approach. Some of Johnson’s basic principals are the
Play Space (an understanding and agreement that all that happens within the session is acting
and pretend) and Impasse (when the play space is broken or the action dies, an /mpasse
occurs which indicates to the therapist that there is material that needs further exploration).
The therapist is basically a screen or puppet for which the client projects their issues onto, and
together they “play” with them. The goal is to discover and explore the stages of

development that the client has blocked or is stuck in, and through the play, with the therapist
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as guide, progress through that stage to improve the quality of life (Johnson, 1982a, 1982b,

1991).

-Renee Emunah’s Five Phase Model consists of Dramatic Play, Scenework, Role
Play, Culminating Enactment and Dramatic Ritual. Emunah’s approach is very pragmatic, and
her style of writing includes lots of practical tips and activities. The method, to some extent
is influenced by Psychodrama and many of the other drama therapy techniques. The approach

basically distills a very useful method of drama therapy that is applicable across most

populations (Emunah, 1994).

-Sue Jennings and Ann Cattanach’s Developmental Paradigm/ EPR (Embodiment,
Projection, Role) Model is similar in basic theory to Developmental Transformation. It is
based on Piaget’s theory of child development through the stages of Embodiment or Sensory
Play, to Projection of play onto objects, and then to the taking on of Roles. This model has
been used with many populations, but has been especially applied to Play Therapy with

children (Cattanach, 1992, 1994)

-Alida Gersie’s Narrative Approach uses stories, myths, fairy tales, folk tales and
legends to contain the issues of the client. It uses material from outside texts and literature
as well as the client’s own stories. Using these narratives as a metaphorical platform, the
drama therapeutic work then uses ritual, movement and embodiment to explore the issues.

(Gersie, 1991, 1996, 1997)
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-Steve Mitchell, Marina Jenkyns, Brenda Meldrum, Phil Jones and Sue Jennings’
Theatrical Approach often uses text or paradigms of theatre (like those of Brecht, Grotowski,
Artuad, and Peter Brook) in the therapy -process. Like the Narrative Approach it uses
theatrical literature and structures to contain the work of the client (Jennings, 1992; Jenkyns,
1990, 1996 ; Jones, 1991, 1996; Mitchell, 1990, 1994; Meldrum, 1993). Occasionally, but
not always, this method leads to “Theatrical Performance”. There are numerous practionners
who describe the benefits of engaging in public performance or performance within the
therapeutic milieu. There is also a subcategory of “Zheatrical Performance”, which is
“Theatrical Performance with Special Populations” which encompasses, generally, public
performances of text-based or self-advocacy pieces presented by clinical populations.

Theatrical Performance can come out of a variety of different approaches and methods.

To continue exploring other search terms in The Drama Therapy Database, in the
Approaches/ Techniques column, there is a third category, stemming out of theatrical
literature and traditions, which is not as much a clinical approach, but a search term I created
to describe a group of articles that are more philosophically based. These are often written
by psychologists with an interest in theatre or theatre professionals with an interest in the
psychological. I have called this category “Theatre and Therapy™. It refers to articles that

compare the theatre process to the therapeutic one, or vice versa.

A fourth category is similar, but based more upon theatrical literature as a metaphor for

pathological disorders or therapy. Often this category will be specifically about a script or a
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playwright. It is named “Dramaturgy- Text/ Metaphor”_ These words will usually appear

together, but not in all cases.

Most of the titles for approaches have come from the wrter’s themselves, and I have
retroactively applied their model of working to most of their earlier works, (before they had
coined the name), to trace the historical development. The exception to this is when an author
is writing on an entirely different subject. There are a lot of grey areas between approaches,
techniques and search-term categories where they overlap. I have, in the Approaches/
Techniques column, liberally applied labels when they may have only a little relevance. 1
have done so to encompass as much information into the search terms as possible.

All drama therapy articles are classified as such first, and a “-*, and then by approach if
possible ( ie: Drama Therapy- Five Phase Model). Of course, there are more non-specific
drama therapy approaches that the authors have not established as paradigms or methods.
Some of these are labelled simply “Drama Therapy”. Sometimes it is not an established
method the author is working with, instead there are techniques employed that are common
and useful to know about when searching for relevant articles. As with the approach specific
articles they are labelled “Drama Therapy” and followed by a “-* and then the technique (ie:
Drama Trerapy- Myth/ Symbolism/ Metaphor). 1 have used this method when describing the

techniques in other fields too (ie: Play Therapy- Storytelling, or Psychology- Role Play).

Projective techniques, specific and non-specific, compose an important part of some drama
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therapy methods. They are, when possible, broken-down into: Puppets, Mask, Make-up,
Video, Dolls, Props, Objects, Drawing, Creative Writing. For a more complete list of all the

columns’ search terms, please see Appendix A

Figure 6 is a graph illustrating a breakdown of some of the most common search terms from
the Approaches/ Techniques column. It is not entirely comprehensive, but it reflects some
of the major areas. Because it does not include every search term included, it is not
statistically accurate. This graph depicts techniques from all fields from which resources were

garnered.

Five Phasec Model

Voice

Fairy Tales

Figure 6: Breakdown of the Drama Therapy Database by Techniques
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The third and last column, Other Keywords contains more defining search terms. When they
have been available, the specific contents and topic breakdowns from within the article have
been used to define its themes even ﬁuther This moves in two directipns, toward more
generalizability, or toward refinement. From a general standpoint, I have tried to describe the
article in broad terms of being principally about Theory, Theory and Techniques, Specific
Techniques, Assessment, Assessment and Evaluation, Research, Multiculturalism, Historical
Perspective, Educational Context, Supervision, Training, Transference/ Countertransference,
Therapeutic Relationship, Process, Aesthetic Distance, Clinical Examples or Case Studies.
These are some examples of the larger, and less specific search terms employed in describing

the articles. Other clinical areas and methodological descriptions also used.

In the opposite direction, toward refinement, I have tried to include the major theorists the
author references if it is key in defining the article (ie: Brecht, Artuad, Grotowski, Peter
Brook, Winnicott, Jung, etc.). Another refinement could be specific texts or scripts named
by the author (ie: Shakespeare’s “The Tempest” or “King Lear”, Peter Shaffer’s “Equus™).
Other keywords that are specific and significant in defining that article as an individual work
are also included. Because this area is oriented to defining the specific articles, the search

terms are often as specific and individual as the articles themselves.

The Profile of an Ideal Article:
The field of drama therapy is so new and so diverse that even when the intended audience is

other professionals, no assumptions can be made on behalf of the writer in terms of the
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reader’s knowledge of the orientation, population and techniques with which the writer
works. As I have reviewed about 70% of the creative arts therapies and drama therapy
literature contained within this database, I f-‘eel it is safe to claim to be an expert on skimming
resources. I have made some observations about the profile of the “easy to read and

understand” article.

In terms of making writing accessible and practical for the reader, I have found the following
to be true. A comprehensive title that describes both the population and approach and, if
possible, the article’s purpose is a great asset when a researcher is still in the initial stages of
culling for valuable resources. An introduction that describes these factors from the outset,
is an even a greater asset. In the section following this abstract-like introduction, a review of
how the methodology, approach or philosophy being discussed has evolved, either in terms
of past literature or the author’s own experiences, orients the reader quickly and allows them
to gain insight into the theoretical underpinnings of the work. A description of the context or
population that the work is happening in or with is a necessary, and yet often overlooked,
component that furthers the reader’s understanding. Articles that are broken down into small
sections that are clearly labelled are much easier to understand at first glace. Even if the article
is theoretically based, most greatly benefit from being grounded with clinical examples. This
is especially true of technique descriptions. Some of the best articles I have read have
contained transcripts of the work itself (longer than one or two lines of dialogue). This is
particularly valuable to students still trying to discern the flavour of drama therapeutic work.

To augment the transcripts, reflections of the drama therapist about what they thought at the
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time and since, add further depth to the writing. My favourite articles are ones that also
include specific descriptions of techniques and activities they have found useful and valuable
themselves, and those which also include pra‘ctical tips. Realistic descriptions of how the work
is structured within the context of which it is unfolding gives enormous insights to the reader.
This may include the referral process, assessment, the treatment goals or structure, the setting
(institutional or private), and evaluation of the work as it continues. Eleanor Irwin or David
Read Johnson’s articles are generally good examples of my observations. I have found their
articles very easy to grasp upon first glance, which encourages me to read the entire article
in depth. Many of the articles contained within 7he Handbook of Dramatherapy (1994,
Jennings, Cattanach, Mitchell, Chesner, & Meldrum) and Dramatherapy: Clinical Studies
(1996, Mitchell) have lured me in the same way, due to their clear writing and easy to

understand descriptions of the contexts and techniques of the work being discussed.

Future Possible Extensions:

As I have written, I have mentioned some of the areas that merit change or extension. One
subject I have ignored until this point, somewhat purposefully, is the division and differences
between North American and British methods, techniques, and approaches. Interesting and
diverse work in also happening in Israel, Ireland and Greece. I have not mentioned the
regional location of the individual writers to create a comprehensive overview of the entire
field of drama therapy. It would be interesting to create an additional column noting the

cultural and geographical location of the author.
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Another area that I observed as deserving of future investigation is the common references
used by many drama therapists from outside the field. As I neared the end of the data entry,
and was using the reference lists in variou; books and articles, I started to become very
interested in the “genealogy” of drama therapy. Some very disparate approaches are
influenced by similar schools of thought, and there are certain fundamental areas that most
drama therapists seem inclined toward. I would like to return to our historical roots in
developmental drama, Slade, Spolin, and Way; anthropology; psychology, Winnicott, Yalom,
Jung and Klein; Goffman and Brian Bates, and the theatre of Brecht, Stanislavski, Artuad,
Shakespeare and Peter Brook, to observe the most commonly referenced materials by drama
therapists. From within the field of drama therapy itself, I would like to create a “hit list” of
the most commonly mentioned books and articles. I started to see patterns that were
emerging, and could almost envisage the “family tree’”” of drama therapy. Perhaps from the top
of this tree, a united theory of drama therapy, one that unites the various approaches, would

be visible.

With the scanning technology available today it is possible to scan a document, run it through
a text recognition program and save it as a word-processing file. This could be an invaluable
resource (to be used privately, of course, due to copyright laws) for those rare, out of print
and obscure documents that have been noted in The Drama Therapy Database. The database
could be linked to these documents, or at least record the file name of where to find the

scanned document in an additional column.



28

And of course there will always be more articles to add. This is a living document. It interacts
with the user. It influences the user, and the user has the power to influence it. As long as
drama therapists write, this work is not ﬁmshed. It will be prone to revisions as new theories
emerge, as populations change, as sophistications in software develop. My hope is that I have
summarized what has been accomplished to this point, and perhaps smoothed the path into

the future for those who use The Drama Therapy Database.
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Part 2: User’s Technical Manual for The Drama Therapy Database

Introduction: Compatibility

This database was written with the Microsoft program Excel 97. It is compatible with Corel
Quattro Pro 8 and is saved as such on the floppy disk. It should also be compatible with
dBASE and Lotus 123 programs too, depending upon how the original document was saved.
It should also be compatible with a Macintosh computer, given that it has a sophisticated
enough spreadsheet function. (Macintosh does have a version of Excel.) If the user is not
using the original software, Excel 97, the author cannot guarantee that the database

spreadsheet will function as it was originally designed.

This manual is designed for those using an IBM compatible computer, with Windows 95 and
Microsoft Excel 97 already installed on the hard drive (usually C:\). The following installation
and user information should be similar for other IBM software programs using the Windows
format. Given that all computers are set-up slightly differently, I cannot anticipate the exact
defaults or other formatting differences of your individual computer and software. I have
made an effort to maintain standard defaults, however, if what appears on your screen is
different from the information contained within this User’s Manual, this is partly to be
expected. In the case of that you are using Quattro, most of the functions are similar, but not
identical to what is contained within in this user’s manual. When there are great differences

I have noted them.
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Getting Started:
Opening Excel:
Double-click on Excel icon on your deslctog;, or go to the start-up menu (the Start button
in the bottom left corner of your screen with the Window flag icon), and under Programs
double-click on the Excel icon there. It looks like a piece of paper on an angle with a blue X
superimposed on it, or just the blue X. The Excel program may be in a Microsoft subfolder
on the start-up menu. Double-clicking on this icon opens Microsoft Excel 97. It will open,

relatively quickly, to a blank worksheet.

If opening The Drama Therapy Database (TDTD) firom a floppy disk or the hard drive:
From this blank worksheet, the next step is to open The Drama Therapy Database. Double-
click on the yellow folder icon on the top toolbar, Open, or go to the File pull-down menu
and double-click Open there. It will open to a default directory, most likely to your C:\ or

hard drive.

If this is the first time you are opening The lirama Therapy Database (TDTD): it will
be on a floppy disk, 3 ¥2" format. On the top tool bar, it will say Look in: and then there will
be a space with, most likely, the icon for the hard drive (a little blue box with a dot) and the
C:\ prompt. The easiest thing to do is to click once on the little down-pointing arrow button
on the end of that space. It will offer you a menu of folders or drives to open. If TDTD is
on a floppy disk (even the little hard disks are called floppies), select that drive name, most

likely A:\ or B:\. It will probably tell you which is appropriate for a 3 14" disk Double-click
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on it. This will open the floppy disk drive. Insert the disk into the disk-drive until the littie
button on the machine pops out. The disk-drive green light will come on, and a list of the
items on the floppy will appear on the wr@ Highlight The Drama Therapy Database with
your mouse pointer and double-click. This will open the database. A message will appear at
the bottom of you screen saying “Opening The Drama Therapy Database” with a counter

bar. It takes a few moments to open as the file is very large.

If TDTD is already installed on your hard drive: open the folder in which it is stored,
highlight The Drama Therapy Database with your mouse pointer and double-click. This
will open the database. The same as opening the file from a floppy, a message will appear at
the bottom of your screen saying “Opening The Drama Therapy Database’™ with a counter

bar. It will take a few moments to open due to the size of the file.

If you don’t know the name of the folder where TDTD is stored, go to the Windows Start-
up Menu (bottom left corner) and highlight Find (the icon is a piece of paper with a
magnifying glass). This will open a dialogue box. Under Files or Folders, type in: The Drama
Therapy Database (spelling counts), and makes sure the C:\ drive is designated to search in
the bottom Look in: box. After the search is complete, it will list The Drama Therapy
Database and a file/ path name; remember it for easier opening next time (ie: mine is
C:\Tina\RESEARCH\The Drama Therapy Database). Double-click on the Excel icon that

will be at the front of the name. This will take you directly into The Drama Therapy Database.
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To save The Drama Therapy Database (TDTD) from the floppy to your hard drive:
once the program is opened from the floppy disk, go to the File menu and click on Save As.
It will ask you to choose a location to Sav; in: and you may have to go through a similar
process as earlier to get to the C:\ drive, using the small down-pointing arrow button at the
end of the top space. Choose a folder in which store TDTD. You do not need to retype the

name of the database, as it should appear in the bottom dialogue box already.

Using The Drama Therapy Database (TDTD):

The following instructions explain how to use the vital functions of The Drama Therapy
Database to find articles, books and resources that are pertinent to your specific needs and
interests. The database information is organized in such a way that it can be either searched
for by any word(s) or string of letters in any of the cells (with the Filter tool), or reordered
according to any of the column headings (with the Sort tool). Once you have found and

organized the information you want, then there is instructions on how to Print your results.

IMPORTANT NOTE TO ALL USERS:

Though there is a Protection feature in Microsoft Excel, it disables both the Filter and Sort
capabilities, so it has not been used. This means that if you make a major error or change the
data in any way, it will possibly change the database permanently. The fail-safe for this is that
the floppy disks have been overwrite protected, meaning that the changed information cannot
be resaved back onto the original disk. If you attempt to save the changes on the floppy disk,

the computer will give you an error message.
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However, if you are working from the hard drive, where the original information was
downloaded, this fail-safe does not protect you. It is recommended that, unless the changes
are intentional, you always hit the “No” b;ltton when ending your session and exiting the
program and it asks you to Do you want to save the changes to Drama Therapy
Database? Do not, at any time, use the Save icon (the floppy disk icon) on the toolbar, or
hit Save under the File menu, as the computer will not question if this is what you intend to
do, and will overwrite the file. The only protection from this is going back and reinstalling the

original from the floppy disk.

How to SEARCH (Filter):

Once the Drama Therapy Database is open, you should see across the top line: Article Title;
Author(s); Journal Title/ Book Title & Editor(s); Date of Publication/ Publishers;
Population/ Context; Approach/ Techniques; and Other Keywords. This is the Headling
Row. Underneath the Heading Row a row of little down-pointing arrow buttons should
appear, one in each column heading. If this is not the case, go to the Data pull-down menu
and choose the Filter submenu, click once beside AutoFilter and the menu should close and
the down-pointing arrow buttons should appear at the top of each column, in the Heading

Row.

These Filter arrow buttons allow for searches for words, names, etc. Click on one. The first
item on the pull-down menu is (All). Always go back to (All), and double-click on it to

return to the full selection. The next item is (Top 10...); frankly, I have never found this
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function of any use. The next item is the important one for defining your search (Custom...).
Appearing on the pull-down menu underneath (Custom...) there will be an alphabetical list
of all the words/ names which are entered first in the cells. Any of these maybe scrolled to and
highlighted (See: A Note about Scroll Bars: below). If that exact value is represented in more
than one cell, then a list of the rows containing that cell value will appear on the screen. If that
cell is unique, then only the one row will appear. However, when more than one name or
search term is entered in a cell, only the first will appear in the alphabetized list. If you are
looking for the specific word or name in the cell contents, and it does not appear first, then

a search must be done to find individual item(s).

To search any column for any value or string of letters highlight and click on (Custom...). A
dialogue box will open. Its title will be Show rows where ... (the column heading of the
arrow button you clicked, for example: Author(s)) and a dialogue box that shows the default
equals. At the end of this dialogue box there is another small down-pointing arrow button.
If you click on it, it will give you choices such as “does not equal”; “begins with™; “ is larger
than™; “is smaller than™ and “contains”. “Contains™ is generally the most appropriate for
finding whatever you need in this type of database. However, I have found it simpler to type
a * (shift 8 on most keyboards), representing strings of letters or words that come before and
after the word/ name that you are interested in.

For example: To find all the references that contain Autism/ or Autistic in the title

of the Article, under the Article Title column, click the arrow butten, click

(Custom..), write *auti* in the dialogue box (This will capture all varniations of the
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word). Then the screen will list only those articles with “auti” in the title. You may

capture some that are not relevant but they are easily overlooked.

The equals *auti* is the same as using the contains option, but remember that the
asterisks have to go before and after the letters, word, name you are searching for,

because, rarely, will one word be alone in a cell.

The arrow at the top of the column you used to define your search will now be blue. To
return to the full database, click the blue arrow, which will give you the pull-down menu

again, double-click on (All) and the whole listing will reappear.

The example was used in the Article Title column to make the point about variations on
words, however, this is not the best way to do a comprehensive search, for just this reason
and others. The Article Title column does not contain the book titles, only journal articles or
individual essays from edited books. Also, language is not common across often different
sources and schools of thought, and words such as Diagnosis, Evaluation, Interview, Analysis
may all mean or imply Assessment. For this reason, there are additional columns of search-
terms provided (Population/ Context, Approaches/ Techniques, Other Keywords), and

I would recommend starting searches there. (Also see Appendix A)

The Filter (Custom...) dialogue box contains the option to search for two search-terms or

keywords simultaneously. It gives you an “and™/ “or” choice.
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For example: in the last column, Other Keywords if you type *archetype* (to find
all articles that discuss the use of archetypes) “and” *theor* (to find all articles
containing theory or theoretical), the list will be reduced to only those articles that
have been classified as both dealing with archetypes “and” theory. However, if you
use the “or” capability, the list will include all the articles on archetypes and all the

articles that are about theory.

At the bottom of all the alphabetized items in the pull-down menu under the down-pointing
arrow buttons in each column are two more useful search items: (Blanks) and (NonBlanks).
These menu items allow simple searches in each column.
For example: to review a list of only books (not essays or journal articles), go to the
“Article Title” column, use the scroll bar to scroll to the end on the list, and
highlight (Blanks). The result will give you a list of all the books in The Drama

Therapy Database.

From shorter selected search lists, you can use other column headings to refine the list more.
For example: to find out what Robert Landy has written about children click on the
down pointing arrow button in Author(s). Write *landy* (it is generally not case
sensitive) in the (Custom..) blank, this will give the list of all of Robert Landy’s work.
Then click on the down-pointing arrow button under Population/ Context and write
*child* and this will further refine the search to only articles about/ for children that

Landy has written.
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To return to the whole list you must click on both blue arrow buttons, and highlight (All)
on each pull-down menu to return to the whole database. This will not work in the case of

trying to refine a search twice in the same column, instead use the “and” option.

To see a listing of some of the majors categories and search-terms entered in the TDTD, in
the Population/ Context, Approach/ Techniques, and Other Keywords columns, and an

explanation of how they are used, turn to Appendix A.

A Note about Scroll Bars:

Scroll Bars facilitate movement through the database. They appear on the far right side of the
screen and along the bottom. At the top there is an up-pointing arrow button and at the
bottom there is a down-pointing arrow button (on the vertical scroll bar). On the horizontal
scroll bar the movement is side to side. There is a small box that slides up and down
depending on the arrow button that is being clicked. This box indicates how clése to the top
or bottom in the document the view is. The view can be changed one row at a time, by
clicking the up arrow button to up and the down arrow button to go down. Faster scrolling
can be done by holding your finger down on the mouse button, when the mouse pointer is
on an arrow button. A third way to scroll is to click on the small mobile box itself, and drag
(by holding down the mouse button) to the approximate place in the database you believe
what your looking for would be, ie: halfway down the slider for references beginning with

“L”
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Yet another way to move around the document is with the black highlight box.
IMPORTANT NOTE TO ALL USERS: The black highlight box will always be
somewhere in the database. It is a heavier black outline surrounding a cell. It is a danger, as
whichever box it is surrounding is designated for changing. Typing when the box is
highlighting a cell will erase the cell contents, and replace the former contents with the new
typed information. If this is intentional, (which is fine, even encouraged, modify the database
to your own needs or interests. Double clicking on a highlighted box will not erase the
contents, but provide a cursor for the contents to be changed without losing the current
information), leave your changes and save upon exiting. However if the changes are
unintentional, immediately, before doing any other typing, go to the backward curved arrow
icon on the top toolbar, and click on it. This is the symbol for Undo, and it will undo the
changes that have been made to the cell. However it only undoes the last action, and if the
undo button is not the first typing after the error, it will not retrieve the information. The
Unde function can also be found in the pull down menu under Edit. Remember, if you do not
want to save the changes to the database, always click on the “No” button when exiting the

program, and the dialogue box asks if you want to save the changes.

Despite its dangers the black highlight box can be used in association with the direction keys
on the key board for a fourth option of moving around the database. Ideally all searches and
sorting options can be done with the scroll bars, on-screen buttons and mouse alone, without

troubling your self with the keyboard, (except to write in your search-terms).
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How to SORT:
The Drama Therapy Database has the capability of changing the order of the information in
the database depending on the Sort instruction. It can be ordered in alphabetical/ numerical
order by any of the column headings: Article Title, Author(s), Journal Title/ Book Title
& Editor(s), Date of Publication/ Publishers, Population/ Context, Approach/
Techniques, and Other Keywords. When a column is designated as the Sort column the rest
of the database information reorganizes itself to maintain its structure (ie. the whole row

moves together into the new order).

The Sort command is on the Data pull-down menu. Click on Data, then click on Sort. This
will highlight the whole database and a dialogue box will appear. It says Sort by: and has a
blank space with a down-pointing arrow button that lists the column headings. Choose the
column heading you want to sort the list by. All the items in The Drama Therapy Data base
will be incorporated, and reordered. You have the choice of Ascending (smallest value to
largest value, alphabetical order) and Descending order (largest to smallest, reverse
alphabetical order). Ascending is the default value, which will happen automatically, unless

you click on the button beside Descending.

The Sort function can sort by just one or multiple column headings. There are three spaces
in which to choose headings. Each of the subsequent boxes have a lower priority that the one

above it.
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For example: To group the Journal Title/ Book Title & Editor(s) together, and have
them appear in alphabetical order, and then in the sequence in which the articles were
published; (ie. all the Arts in Psychot;zerapy articles grouped together in order of their
" date of publication) in the first blank Sort by box, open the list of headings by clicking
on the down-pointing arrow button, highlight Journal Title/ Book Title &
Editor(s), and it will appear in the blank space. The repeat the process in the second
box labelled Then by, only this time choose Date of Publication. If the third Then
by box is empty leave it. If it contains a value then click the arrow button and
highlight (none). Then click on OK. It takes a few moments for the computer to
reorder the list to the new specifications. This is normal. (The database is formatted
by Author(s), Date of Publication and then by Journal Title/ Book Title and Editor

when you open it.)

Important SORT Tips:
-If you are using Quattro Pro 8, as you will have probably noticed, there a Sort function
contained within the Filter selection under the down-pointing arrows in the Headings Row,

in addition to the Sort function under the Tools menu.
-The computer will not allow you to sort if two of the Sort by boxes contain the same value.

-If the black highlight box is off edges of the information cells containing data, the Sort

function will not work.
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-If for some reason, the column headings do not appear, but you see Column A, Column B
etc., double check that the button beside My list has header row is highlighted. Once in the
preparation of the database my computer -mysteriously undesignated my header row, the

solution to this problem, should it happen to you, is below in How to Print: (Sheet).

-If you are sorting by the Population/ Context, Approach/ Techniques, or Other Keywords
columns, the information is often ordered differently by what seemed to be of the most
importance in the article, and often contains multiple entries per cell. Thus sorting by these
columns will not guarantee that all the articles with similar subject matter will be grouped in
order. In the Population/ Context column I have tried to keep the age of the population first
(ie: Children, Adolescents, Adults, Elderly), and tried to order the cells by age, Children
appearing first etc. However subsequent labels will not appear always together. For these
columns, if you are interested in a particular group, approach or keyword it more efficient to

use the Search/ Filter mechanism.

-When you do a Search/ Filter and have a more defined list of articles that you are interested
in you can reorder the shortened list without exiting and reordering the entire database.

Simply use the Sort mechanism on the selected list as you would on the entire database.

-If you are using the Sort function, but have a row, column or cells highlighted (in black) in
the database (intentionally or by accident), you will receive a dialogue box before the Sort

is continued. It will ask you if you want to: expand the selection? Always make sure this is



42
the highlighted option. (It is the default.) If you do not expand the selection, it will simply
reorder the highlighted portion, and the structure of the database will be mixed-up. If this

happens, be sure to not Save the changes, in process of use or in exiting.

How to PRINT:

This is the most complicated and the perhaps the most useful of The Drama Therapy Database
functions. It will print what you have on the screen, for example the shortened lists of articles
on topics of specific interest for you to take to the library to find. To print the whole database
takes very long time (over an hour and a half on my printer), and honestly, is not much use
In its entire written form, because it is simply too much information. It prints in a very small
format to fit on a single page (8 2 x 11), about the equivalent of 6 point font. On 8 2 x 14
sheets, you can afford to go to 8 point, but it takes a little readjustment. To print the entire

database on 8 2 x 11 paper is about 72 pages, on 8 ¥4 x 14, it is 96, but much easier to read.

To print your list, first go to Page Setup under the File menu. This opens a dialogue box with

four headings: Page, Margins, Header/ Footer, Sheet.

The Page page is first. Make sure that the Paper Orientation is Landscape and not Portrait.
If you are using 8 ¥ x 11 paper, click the dot beside Adjust to and use the up-pointing arrow
button to adjust the size to 65%. The default is 100%. This will fit the data base onto one
sheet of paper, without changing the default margin settings. At the bottom of this window,

double check that you paper size is correct and if it is not use the down-pointing arrow
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button at the end of the space to specify 8 % x 11 (it is the default and will generally be
correct). If you have 8 % x 14 paper, click the Adjust to toggle button so it is highlighted and
use the arrows until 85% shows in the box. Ensure that your paper size is correct, 8 12 x 14,

(see above) in the bottom box.

The next page is Margins, to access it click on the tab at the top. The default margins that

are preset should be fine.

The next page is Headers/ Footers. It appears that once a custom header/ footer is designed
it is stored forever. I have not figured-out how to remove my old ones, so you will see them
there. The default is (none). You can click the down-pointing arrow button to see these and
the other defauits, or create you own. If; for example, you are printing multiple custom lists,
it is wise to label them. To do this click on Custom Header and write the title you desire in
the box. There are three columns available for your custom header to appear in the left, the
middle, or the right. There are instructions on the page that tell you what the various icons
that appear there are. They can, for example, insert automatically the date or time, page
number, or the filename. The same apply for Footers. Custom design the printout to your

specifications and satisfaction.

The last page is Sheet. This is where it gets slightly more complicated. For the Heading Row
to appear at the top of each page you print (which is helpful), ignore Print Area, because it

will print everything unless you specify otherwise as a default, and go to Print Titles.
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Hopefully, it says in Rows to repeat at top box: $1:$1. If it doesn’t, you can try typing this
in. It ideally will have worked to designate, in programmers language, the top row as the
headings to repeat. If it says anything else> but $1:81 (with no space) it will not print the
correct heading row. If this is the case it is also likely you have been having trouble with your
Sort function in that the correct headings are not designated. The solution that was
mentioned above is this. There is a gridded icon with a red arrow at the end of the Rows
to repeat box click on it. It will take you to the top of the database. Click the grey “1" on
the far left side. This 1 (1,2,3 down the side and A, B, C across the top) is part of the boarder
that surrounds the screen, so make sure that you have scrolled to the top entry. This will be
the Header Row. This will highlight the whole row. Go back up to the now floating dialogue
bar which should now contain the $1:$1 and click on the little icon with the white box and
the red arrow. You will be back to the Sheet page, with the correct row designated. I have
found this operation touchy in the past and for some reason, not entirely consistent, so

proceed with caution.

In addition to this, this page also asks some other questions. Do you want the Gridlines to
appear? I usually highlight this box because it makes the printout much easier to read. The
Drama Therapy Data base is in Black and White already, but if you have added colour, there
should be not a dot in this box. Ignore Draft Quality, if you want. I have never used it.
Ignore the Row and Column Headings box because this highlighted will print the numbers
down the side and the letters across the top (which only take up space on the printout, so I

don’t bother). They may be useful to you. If you do chose to print these, it will change the
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width of the database. To ensure this does not make the data spill over onto another page,
check with the Print Preview (see below). If it has spilled over, this can be fixed two ways;
either go back to Adjust to and reduce the ;mount another 5% (65% to 60%), or see below

for margin adjustment.

On each of these four pages there are three buttons along the right top side, Print, Print
Preview, and Options. Print will send your list to the printer, but you do not want to do this
until you have checked your Print Preview to see that everything is to your satisfaction and
all the settings are correct. If these are not correct, they can muddle your printout easily, and
since it takes quite awhile to print, it is worthwhile previewing. Options will take you to your
individual Printer Options specifications and unless there is a problem to troubleshoot later,
it shouldn’t be necessary to go there. Perhaps only to check that the paper size that you

designated under Page is correct on these pages.

Click on Page Preview. This will open a screen that appears as your paper will appear, only
much smaller and there is a toolbar across the top. Check that there are all the columns on the
one page (there should be 7). If there are not, click on Page Setup from the toolbar, and
return to the Page page. Shrink the size by 5% under Adjust to and return to Page Preview
to see if it all fits now. Another option is to click the Margins button and drag the margins
on the page slightly larger. ( when its positioned on biack margin tabs the mouse pointer will
turn to a line with an arrow on each side. Click on the tabs at the outside, hold the mouse

key down and drag it slightly larger toward the edge of the page.)
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To view the database in its real size click on the Zoom button on the top of the page. Double
check that your Headers and Footers are where you wanted them and spelled correctly. Click
on the Next button and ensure that the Row Headings have appeared on each of the
subsequent pages. Have the gridlines appeared? If you are satisfied with the product you see
on the screen then click on Print. If there are problems, go back to Print Preview under the
File menu or click on the Setup button on the top tool bar to check your settings. I have

learned to use this program through trial and error. Good Luck

Troubleshooting:

-The database is floating and smaller than the screen size: In the top right-hand corner
are three buttons: a “-*; two small squares with dark lines across the top, one overlapping
the other; and an “X™. Click on the middle button, one large square with a dark line across
the top icon should appear and the view should take up the full window. The “~“ makes the
window disappear entirely, but it is still open, and is indicated by a small dialogue bar in the
bottom right-hand comner, Click the larger square with a dark line icon for the window to
return to full screen size. Clicking the “X* will make the window close and must be reopened

using the Open icon or using Open on the File menu.

-An empty page appeared instead of The Drama Therapy Database when I opened it:
The file that you open is called The Drama Therapy Database. As whole is referred to by
Excel as a Workbook, the main page is labelled The Drama Therapy Database. It is a Sheet

or Worksheet of the Workbook. The other sheets contain no information. If you have an
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interest in making more specific search-refine lists, you can Copy (not Cut) and Paste from
the first worksheet to these blank sheets. Movement from sheet to sheet in the workbook is
done with the small left-pointing and right-;-bointing arrows in the bottom left corner. Or you
can click on the tabs, Sheet 2, Sheet 3, etc. If you open The Drama Therapy Database file,
but is not visible on the screen use the left-pointing arrow buttons to change worksheets, and

the correct page containing The Drama Therapy Database information should appear.

Contact Number:

If you have any questions, technical or philosophical, please do not hesitate to call or email:
Kristina Bye

(450) 827-2022

-or-

Kristina_Tucker@msn.com
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Appendix A: Categories and Search Word Lists

To give the user an idea of some of the Population/ Context, Approach/ Techniques, and
Other Keywords search-terms that have been used please reference the lists below to make
defining your searches easier. Keep in mind that multiple classifications may be entered in the

same cell.

Population/ Context:
Either the Age, Population, Context, or intended Audience the article is addressing:

Children

Adolescents

Adults

Elderly (including Older People)

Family

Actors

Audience

Community

Creative Arts Therapists (articles aimed at professionals as an audience, and those
about professional development)
Training Creative Arts Therapists
Drama Therapists
Training Drama Therapists
Teachers
Nurses

Developmental Delay (which encompasses all labels such as Mental Disability, Mental
Retardation, Learning Disabled (as the British use the term), Subnormal,
Special Education, etc.)

Down’s Syndrom

Autism
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Physical Disabilities
Brain Damage
Visual Impairment
Hearing Impairment
Emotional Disturbance
Behavioural Disorders
Conduct Disorders
Psychiatric Disorders
Schizophrenia
Thought Disorders
Depression
Anxiety
Eating Disorders (including Anorexia Nervosa, and Bulimia Nervosa)
Financial Issues ( which includes Homelessness, Disadvantaged Populations etc.)
Substance Abuse (including Drug and Alcohol issues and recovery)
Marginalized Groups (also referred to as refugees, migrants and those populations
that Augusto Boal labels as such)
Survivors of Abuse
Survivors of Sexual Abuse
Survivors of War
PTSD (Post-traumatic Stress Disorder)
Offenders
Youth Offenders
Correctional Facilities
Hospitalization
Day Treatment
Outpatient Treatment

Approaches/ Techniques:

This column contains theoretical paradigms, models, methods and approaches from within
the field of drama therapy, or fechmiques common in the practice of drama therapy from other
disciplines. The discipline generally is noted first, followed by the approach and then the

technique. (For example: Drama Therapy- Narrative Approach/ Storytelling/ Myth/ Fairy
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Tales, or Psychotherapy- Projective Techniques: Puppets/ Performance.)

Drama Therapy
-Developmental Transformations (for example the work of David Read
Johnson)
-Developmental Paradigm/ EPR Model (for example the work of Sue
Jennings, Ann Cattenach, Anna Chesner etc.)
-Role Theory (for example the work of Robert Landy)
-Theatrical Approach (for example the work of Steve Mitchell, Sue Jennings,
Robert Landy, Brenda Meldrum etc.)
-Narrative Approach (for example the work of Alida Gersie etc.)
Brief Drama Therapy
Creative Expressive Arts Therapies
-Dance Movement
-Music Therapy
-Art Therapy
-Poetry Therapy
Developmental Drama (as a precursor of Drama Therapy)
Creative Dramatics (as a precursor of Drama Therapy, for example the work of Peter
Slade)
Creative Dramatics with Special Populations
Narrative Therapy (for example the work of Epson and White)
Story/ Storytelling
Fairy Tales
Folk Tales
Legends
Myth
Text
Dramaturgy- Text/ Metaphor
Projective Techniques:
Masks
Puppets
Make-up
Video
Art
Objects/ Props
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Doll
Role Play
Sand Tray Therapy (including Sand Play)
Play Therapy (for example the work of Ann Cattenach etc.)
Metaphor
Symbolism
Shamanism
Ritual
Anthropology (as it relates to Drama Therapy)
Professional Development
Action Methods
Psychodrama (as the techniques relate to Drama Therapy)
Sociodrama
Theatrical Performance
Theatrical Performance with Special Populations
Improvisation
Theatrical Techniques
Games
Self-Advocacy
Forum Theatre
Sesame
Voice
Multimodal (Drama Therapy and Creative Expressive Arts Therapies as they relate
to a larger treatment context, ie: a hospital)
Psychotherapy
Psychoanalysis
Family Therapy
Crisis Intervention
Noh Theatre
Literature Review
Bibliography

Other Keywords:
Educational Context (school, learning etc.)
Assessment
Assessment and Evaluation
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Theory

Theoretical Perspective (the philosophy of a particular practionner/ author)

Theory and Clinical Technique (the philosophy and application of methods specific
to an approach or paradigm)

Techniques (Specific)

Transcripts

Case Study (an article dedicated to one individual or a group’s process)

Clinical Example(s) (vignettes to illustrate the author’s technique or clinical
application of their method)

Historical Perspective (articles/ books written before 1970, and the advent of Drama
Therapy as a profession; or an article written about the historical development
of an approach or technique)

Research/ Research Study

Archetypes

Dreams

Shakespeare (and a variety of texts by the Bard)

Ibsen

Ionesco

Peter Shaffer

Peter Brook

Stanislavski

Grotowski

Multiculturalism: (many different countries)

Cultural Identity (type *cult* for all references on variations of this word)

Themes

Transference/ Countertransference

Resistance

Bereavement

Edited Book

Interview with: (various)

Overview (usually an introduction)

These are by no means complete lists of all the search-terms available to create and define

searches, but they give some guidance as to what the major items are, and what is implied by



57

their use. For a more complete description of how the Population/ Context, Approach, and
Keywords were chosen and defined, see Part 1: The Process of Assembling The Drama

Therapy Database.



Appendix B: Hard-copy of The Drama Therapy Database

(Sorted by Author, Date of Publication, and Journal Title/ Book Title & Publishers)
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